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Development Milestones  
in a Child

Development milestones are a set of functional 
skills or age-specific tasks that most children can do 
at a certain age. These milestones help the teacher 
identify and understand how children differ in 
different age groups.

Age
5 - 8 Years

Physical

Language

Cognitive

Emotional/
Social

•	 First permanent tooth erupts
•	 Shows mature throwing and catching patterns
•	 Writing is now smaller and more readable
•	 Drawings are now more detailed, organised and have a sense of depth

•	 Vocabulary reaches about 10,000 words
•	 Vocabulary increases rapidly throughout middle childhood

•	 Attention continues to improve, becomes more selective and adaptable
•	 Recall, scripted memory, and auto-biographical memory improves
•	 Counts on and counts down, engaging in simple addition and subtraction
•	 Thoughts are now more logical

•	 Ability to predict and  interpret emotional reactions of others enhances
•	 Relies more on language to express empathy
•	 Self-conscious emotions of pride and guilt are governed by personal responsibility
•	 Attends to facial and situational cues in interpreting another’s feelings
•	 Peer interaction is now more prosocial, and physical aggression declines

If you cannot do great things, do small things in a great way.



Age 
9 - 11 Years

Age 
11 - 20 Years

Physical

Physical

Language

Cognitive

Cognitive

Emotional/
Social

Emotional/
Social

•	 Motor skills develop resulting in enhanced reflexes

•	 If a girl, reaches peak of growth spurt
•	 If a girl, motor performance gradually increases and then levels off
•	 If a boy, reaches peak and then completes growth spurt
•	 If a boy, motor performance increases dramatically

•	 Ability to use complex grammatical constructions enhances
•	 Conversational strategies are now more refined

•	 Applies several memory strategies at once
•	 Cognitive self-regulation is now improved

•	 Is now more self-conscious and self-focused
•	 Becomes a better everyday planner and decision maker

•	 Self-esteem tends to rise
•	 Peer groups emerge

•	 May show increased gender stereotyping of attitudes and behaviour
•	 May have a conventional moral orientation

Managing the children’s learning needs according to their developmental 
milestones is the key to a successful teaching-learning transaction in the 
classroom.

Family is the most important thing in the world.



Lesson Plans

Knowing yourself is the beginning of all wisdom.

Teaching Pedagogies

Pedagogy is often described as the approach 
to teaching. It is the study of teaching methods 
including the aims of education and the ways in 
which such goals can be achieved.

A lesson plan is the instructor’s road map which specifies what students need to learn and 
how it can be done effectively during the class time. A lesson plan helps teachers in the 
classroom by providing a detailed outline to follow in each class.

A lesson plan addresses and integrates three key components:

  Learning objectives

  Learning activities

  Assessment to check the student’s understanding

A lesson plan provides an outline of the teaching goals:

1.  Identify the learning objectives.
2.  Plan the lesson in an engaging and meaningful manner.
3.  Plan to assess student’s understanding.
4.  Plan for a lesson closure.

Present the lesson plan.

Reflect on what worked well and why. If needed, revise 
the lesson plan. 

Before the class

During the class

After the class



If you have no confidence in self,  
you are twice defeated in the race of life.

Teaching Strategies

Numerous strategies have evolved over the years to facilitate the teaching-learning process 
in the classrooms.

Bloom’s Taxonomy

Bloom’s Taxonomy was created by Dr Benjamin Bloom and several of his colleagues, to 
promote higher forms of thinking in education instead of rote learning. There are three 
domains of learning: cognitive (mental), affective (emotional), and psychomotor (physical). 
However, when we refer to Bloom’s Taxonomy we speak of the cognitive domain. Bloom’s 
Taxonomy is a list of cognitive skills that is used by teachers to determine the level of 
thinking their students have achieved. As a teacher, one should attempt to move students 
up the taxonomy as they progress in their knowledge.

Teachers should focus on helping students to remember information before expecting 
them to understand it, helping them understand it before expecting them to apply it to 
a new situation, and so on.

Student 
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Group  
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Performance 
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Artificial Intelligence-XII (Ver.3.0) (Lesson Plan)

Teaching Objectives

By the end of this unit, students will be able to:

�� Understand the basics and process of communication.
�� Identify and apply principles of effective and active listening.
�� Recognise parts of speech and their roles in sentence formation.
�� Construct grammatically correct sentences and coherent paragraphs.
�� �Differentiate sentence types (simple, compound, complex; active/passive; declarative/

interrogative/etc.).
�� Apply the RESPECT model to improve active listening and communication.

Teaching Plan�

Number of Periods
Theory Practical

4 2

Introduction (Engagement)
Interactive Warm-up Questions:
•	 What is the difference between speaking and communicating?
•	 Can listening skills impact how well we understand someone?
•	 Have you ever misinterpreted a message? Why do you think that happened?
Engagement Activity:
•	� “Broken Telephone” game: Whisper a sentence around the class. Discuss how the message 

changed and what affected communication.

Lesson Delivery (Explanation & Demonstration)
1. 	 Understanding Communication
	 Concepts:

•	 Definition of communication as a two-way process.
•	 Elements: Sender, Receiver, Channel, Encoding, Decoding, Feedback.

Communication Skills-IV1

Part-A: Employability Skills



8 Artificial Intelligence-XII (Ver.3.0) (Lesson Plan)

	 Demonstration:
•	 Diagrammatic explanation of the communication cycle.

	 Activity:
•	 Role-play exercise: Students act as sender/receiver pairs to deliver a message and provide 

feedback.
2. 	 Active Listening & RESPECT Model
	 Concepts:

•	 Importance of listening in communication.
•	 Five phases: Receiving, Understanding, Remembering, Evaluating, Responding.
•	 RESPECT acronym (Remove, Eye Contact, Show attention, Pay attention, Empathise, Clarify, 

Tune-in).
	 Activity:

•	 RESPECT Poster Creation: Small groups make posters explaining each component of 
RESPECT.

	 Discussion:
•	 Share real-life scenarios where listening changed an outcome (school, home, etc.).

3. 	 Overcoming Listening Barriers
	 Concepts:

•	 Types of barriers: being preoccupied, distractions, mindset biases, personal considerations.
•	 Strategies to overcome: mindfulness, suitable environment, empathy.

	 Group Discussion:
•	 Think-pair-share: Identify a common barrier in a specific scenario (e.g., noisy classroom, 

family dinner) and how to overcome it.
4. 	 Parts of Speech and Sentence Formation
	 Concepts:

•	 Basic parts: Noun, Pronoun, Verb, Adjective, Adverb.
•	 Supporting parts: Article, Preposition, Conjunction, Interjection.

	 Activity:
•	 Sentence building game: Students pick a part of speech card and collaboratively build 

meaningful sentences.
5. 	 Sentence Structure & Types
	 Concepts:

•	 Types: Simple, Compound, Complex.
•	 Voice: Active and Passive.
•	 Purpose-based types: Declarative, Interrogative, Imperative, Exclamatory.

	 Activity:
•	 Sort & Classify: Provide sentences. Students classify them into the right categories.



9Artificial Intelligence-XII (Ver.3.0) (Lesson Plan)

	 Worksheet:
•	 Convert active to passive and vice versa.

6. 	 Paragraph Writing
	 Concepts:

•	 Structure: Topic sentence, Supporting sentences, Concluding sentence.
•	 Importance of coherence and unity.

	 Activity:
•	 Write a paragraph titled “My Favourite Day at School” using proper paragraph structure.

Extension
•	 Why is feedback important even in daily conversations?
•	 Can a message still be misunderstood even if the speaker uses clear words? Why?
•	 How does your body language affect your communication?
•	 Why do we need to focus on sentence structure when speaking or writing?
•	 What do you understand by “barriers to active listening”? Can you give one example from 

your life?

Evaluation
•	 Multiple-choice, True/False, and Fill-in-the-blanks based on communication, RESPECT model, 

sentence types, and punctuation.
Practical Tasks:

•	 Pair Activity: Practice a conversation using gestures, feedback, and RESPECT.
•	 Paragraph Writing: Evaluate grammar, punctuation, and clarity.

Suggested Activity 

“Design Your School Campaign” Project:
•	 Create posters showing how to use RESPECT in real-life conversations (e.g., Teacher-student, 

Parent-child).
•	 Role-play showing a conversation where a barrier causes miscommunication, then re-enact 

showing how to overcome it.

Teaching Objectives

By the end of this unit, students will be able to:

�� Understand the basics and process of communication.
�� Identify and apply principles of effective and active listening.
�� Recognise parts of speech and their roles in sentence formation.
�� Construct grammatically correct sentences and coherent paragraphs.

Self-Management Skills-IV2
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�� �Differentiate sentence types (simple, compound, complex; active/passive; declarative/
interrogative/etc.).
�� Apply the RESPECT model to improve active listening and communication.

Teaching Plan �

Number of Periods
Theory Practical

4 2

Introduction (Engagement)
Interactive Warm-up Questions:

•	 What is the difference between speaking and communicating?
•	 Can listening skills impact how well we understand someone?
•	 Have you ever misinterpreted a message? Why do you think that happened?

Engagement Activity:
•	 “Broken Telephone” game: Whisper a sentence around the class. Discuss how the message 

changed and what affected communication.
Lesson Delivery (Explanation & Demonstration)
1. 	 Understanding Communication
	 Concepts:

•	 Definition of communication as a two-way process.
•	 Elements: Sender, Receiver, Channel, Encoding, Decoding, Feedback.

	 Demonstration:
•	 Diagrammatic explanation of the communication cycle.

	 Activity:
•	 Role-play exercise: Students act as sender/receiver pairs to deliver a message and provide 

feedback.
2. 	 Active Listening & RESPECT Model
	 Concepts:

•	 Importance of listening in communication.
•	 Five phases: Receiving, Understanding, Remembering, Evaluating, Responding.
•	 RESPECT acronym (Remove, Eye Contact, Show attention, Pay attention, Empathise, Clarify, 

Tune-in).
	 Activity:

•	 RESPECT Poster Creation: Small groups make posters explaining each component of 
RESPECT.

	 Discussion:
•	 Share real-life scenarios where listening changed an outcome (school, home, etc.). 
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3. 	 Overcoming Listening Barriers
	 Concepts:

•	 Types of barriers: being preoccupied, distractions, mindset biases, personal considerations.
•	 Strategies to overcome: mindfulness, suitable environment, empathy.

	 Group Discussion:
•	 Think-pair-share: Identify a common barrier in a specific scenario (e.g., noisy classroom, 

family dinner) and how to overcome it.
4. 	 Parts of Speech and Sentence Formation
	 Concepts:

•	 Basic parts: Noun, Pronoun, Verb, Adjective, Adverb.
•	 Supporting parts: Article, Preposition, Conjunction, Interjection.

	 Activity:
•	 Sentence building game: Students pick a part of speech card and collaboratively build 

meaningful sentences.
5. 	 Sentence Structure & Types
	 Concepts:

•	 Types: Simple, Compound, Complex.
•	 Voice: Active and Passive.
•	 Purpose-based types: Declarative, Interrogative, Imperative, Exclamatory.

	 Activity:
•	 Sort & Classify: Provide sentences. Students classify them into the right categories.

	 Worksheet:
•	 Convert active to passive and vice versa.

6. 	 Paragraph Writing
	 Concepts:

•	 Structure: Topic sentence, Supporting sentences, Concluding sentence.
•	 Importance of coherence and unity.

	 Activity:
•	 Write a paragraph titled “My Favourite Day at School” using proper paragraph structure.

Extension

•	 Can motivation come from within? Can you give an example?
•	 How do you feel when you achieve a goal?
•	 What is the most stressful situation you have faced and how did you handle it?
•	 Why is it important to write down our goals?
•	 What are some things that help you stay positive when you are upset?
•	 How does personality affect the way you make friends?
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•	 What is the difference between being shy and being introverted?
•	 Why is journaling useful in understanding ourselves?
•	 What does “SMART” stand for in goal-setting? Can you give an example?
•	 How does stress affect your health and relationships?

Evaluation

•	 Multiple-choice, True/False, Fill in the blanks based on types of motivation, SMART goal setting, 
stress management strategies, and personality traits.

•	 Write a paragraph explaining how you manage stress.
•	 Describe a SMART goal and explain why it’s realistic.
Practical Tasks:
•	 Prepare a poster on: “My SMART Goal Plan”.
•	 Group role-play: Practice “positive self-talk” in a stressful situation.

Suggested Activity 

•	 Write 5 words that best describe your personality and one goal you want to achieve.
•	 Students perform a skit showing how to manage stress positively using techniques discussed.
•	 Design a poster showing how they plan to achieve one SMART goal.

Teaching Objectives

By the end of this unit, students will be able to:

�� Understand the concept and structure of spreadsheets and presentation software. 
�� Perform basic operations in LibreOffice Calc such as entering data, formulas, and functions.
�� Use advanced spreadsheet features like sorting, filtering, and formatting.
�� Create and edit digital presentations using LibreOffice Impress.
�� Insert images, text, and graphical elements into slides and save/export presentations.

Teaching Plan�

Number of Periods
Theory Practical

5 3

Introduction (Engagement)
Discussion Starters:
•	 Have you ever seen your parents using Excel or Google Sheets? What do you think it’s for?
•	 Can digital presentations help make your school projects more impressive?

ICT Skills-IV3
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	 Activity:
•	 Show a short demo of a spreadsheet (rows, columns, active cell) and a presentation slide 

(with text and images) to introduce the difference between the two tools.
Lesson Delivery (Explanation & Demonstration)
1. 	 Introduction to Spreadsheets and Calc Interface
	 Concepts:

•	 Spreadsheet definition
•	 Rows, columns, cells, cell address, and active cell
•	 Components of LibreOffice Calc (Menu bar, Toolbars, Sidebar, Formula Bar)

	� Activity:
•	 Open LibreOffice Calc and identify components 
•	 Explore what happens when data is entered in different types (text, numbers, date)

2. 	 Performing Basic Operations in Calc
	 Concepts:

•	 Entering, editing, deleting data
•	 Selecting and working with cells
•	 Saving and opening spreadsheets

	� Activity:
•	 Create a simple student mark list
•	 Enter and edit formulas such as =A1+B1, =SUM(A1:A5)

3. 	 Functions and Data Manipulation
	 Concepts:

•	 Use of SUM, AVERAGE, MAX, MIN, COUNT
•	 Logical Functions (IF, AND, OR)
•	 Use of Formula bar, Fill Handle 

	� Activity:
•	 Calculate total, average, and highest marks using functions
•	 Auto-fill a number series
•	 Use fill handle to apply formula 

4. 	 Formatting and Advanced Features in Calc
	 Concepts:

•	 Formatting cells: font, alignment, colour
•	 Sorting and Filtering data
•	 Password protection in spreadsheet
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	 Activity:
•	 Format the student data sheet (headings bold, change colours)
•	 Sort students by marks
•	 Apply filters to view only a specific section

5. 	 Introduction to Presentation Software
	 Concepts:

•	 Features and advantages of presentation software
•	 Interface of LibreOffice Impress
•	 Creating and saving a presentation

	 Activity:
•	 Create a 3-slide presentation on “My Favourite Festival”

○	 Slide 1: Title 
○	 Slide 2: Text and Image
○	 Slide 3: Graphic Shape and summary

6. 	 Enhancing Presentations with Formatting & Graphics
	 Concepts:

•	 Adding slides, text, images, shapes
•	 Aligning and formatting text
•	 Inserting images from files and gallery

	 Activity:
•	 Add bullet points, align text, and insert an image on a slide
•	 Draw a shape (sun or star) and use colour fill

Extension

•	 What is the difference between a cell and a worksheet?
•	 Which function would you use to find the highest value?
•	 What does the = sign indicate in a spreadsheet?
•	 How do we insert a new slide in LibreOffice Impress?
•	 Can you name two advantages of using presentation software?
•	 Why is it important to save a file in different formats?
•	 What is the shortcut key for printing in Calc?
•	 What are the uses of filters in a spreadsheet?
•	 What happens when you use the fill handle?
•	 What is the difference between SUM and AVERAGE functions?
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Evaluation

•	 Based on rows, columns, formulas, Calc functions, Impress shortcuts, and text formatting.
•	 Explain how to apply a formula in a spreadsheet.
•	 Describe the steps to insert and format an image in a presentation.
Practical Tasks:

•	 Create a spreadsheet showing marks of 5 students and use functions (SUM, AVERAGE).
•	 Create a 3-slide presentation and format text with colours and alignments.
•	 Prepare a digital mark sheet for your class using Calc.
•	 Create a presentation titled “My Role Model” using Impress with 3 slides (Text, Image, 

Summary).

Suggested Activity 

Design a report card, enter marks, and calculate total and average using formulas.
Students in groups create a presentation on a tech topic using LibreOffice Impress (e.g., “Benefits 
of Internet”).
Use Insert → Function Wizard to explore and apply different functions (Mathematical/Statistical).

Teaching Objectives

By the end of this unit, students will be able to:

�� Define the concepts of entrepreneur and entrepreneurship.
�� Describe the qualities and functions of a successful entrepreneur.
�� Understand different types of entrepreneurs and startups.
�� Identify motivational factors and entrepreneurial attitudes.
�� Apply entrepreneurial competencies such as initiative, decision-making, and team-building.
�� Reflect on real-life entrepreneurial journeys and develop perseverance.    

Teaching Plan�

Number of Periods
Theory Practical

5 2

Introduction (Engagement)
Warm-up Questions:

•	 What do you think makes someone an entrepreneur?
•	 Have you ever thought of a business idea to solve a problem around you?
•	 Can a student be an entrepreneur? How?

Entrepreneurial Skills-IV4
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Starter Activity:
•	 Share a short video or real-life story of an inspiring young entrepreneur (e.g., Pooja’s or Anuj’s 

journey from the chapter) and have students share what inspired them.
Lesson Delivery (Explanation & Demonstration)
1. 	 Entrepreneur and Entrepreneurship
	 Concepts:

•	 Definitions from various perspectives: economic, psychological, sociological, management.
•	 Characteristics: Economic activity, risk-taking, resource optimisation, and opportunity 

identification.
	 Activity:

•	 Students write their own one-line definition of an entrepreneur.
•	 Role-play as different types of entrepreneurs (service, industrial, agricultural, etc.)

2. 	 Qualities and Functions of an Entrepreneur
	 Concepts:

•	 Key qualities: initiative, hard work, motivation, risk-taking, decision-making, etc.
•	 Functions: identifying opportunities, putting ideas into action, resourcing, managing the 

business.
	 Activity:

•	 “Match the Function” game – match tasks to entrepreneurial functions.
•	 Group discussion on the importance of perseverance using Shruti’s story.

3. 	 Types of Entrepreneurs and Startups
	 Concepts:

•	 Types: Social, Professional, Women, Technical, Non-technical, IT, etc.
•	 Characteristics of startups and the role of Startup India.

	 Activity:
•	 Create a collage or mind map of different entrepreneurs.
•	 Compare small businesses vs. startups using a Venn diagram.

4. 	 Entrepreneurial Attitudes and Competencies
	 Concepts:

•	 Competencies: decisiveness, initiative, stress management, goal-setting, creativity.
•	 Attitudes: optimism, perseverance, interpersonal skills.

	 Activity:
•	 Read Rachna, Sunny, and Sonia’s stories. Identify traits shown.
•	 Chart activity: “My Entrepreneurial Strengths” – students reflect and list their 3 top traits.

Extension

•	 What makes a good business idea?
•	 Why is it important to learn from failure?
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•	 What do you understand by the term “initiative”?
•	 What is one challenge faced by startups?
•	 How do social entrepreneurs differ from business entrepreneurs?
•	 Why is team-building important for business success?
•	 What is the difference between a wage employee and an entrepreneur?
•	 Can you name a woman entrepreneur who inspires you? Why?
•	 What is a startup? Can you give an example from India?
•	 What role does self-confidence play in starting a business?

Evaluation

•	 MCQs, Fill in the blanks, and True/False based on entrepreneurial functions, types, and qualities.
•	 Short & Long answer questions, Competency-based questions as well as case study on 

Entrepreneurs.

Suggested Activity 

•	 Do a debate on  “Are entrepreneurs born or made?”: Divide class into two teams, one supporting 
“born” and the other “made”.

•	 Students create a 3-slide presentation on an Indian entrepreneur (e.g., Suriya Prabha of Youcode) 
using storytelling and visuals.

Teaching Objectives

By the end of this lesson, students will be able to:

�� Understand the meaning and importance of green skills and green jobs.
�� Identify green jobs in various sectors such as agriculture, transportation, construction, and energy.
�� �Recognise the significance of sustainability, ecosystem preservation, and climate change 

adaptation.
�� �Explain how individuals and industries can reduce waste, conserve resources, and minimise 

environmental damage.
�� Reflect on how green jobs contribute to a greener economy and a healthier planet.

Teaching Plan�

Number of Periods
Theory Practical

4 2

Introduction (Engagement)
Warm-up Discussion:
•	 Ask: What does “going green” mean to you?

Green Skills-IV5
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•	 Have students share examples of eco-friendly actions they do at home (e.g., using cloth bags, 
planting trees).

	 Starter Activity:
•	 Show images of solar panels, green buildings, and electric vehicles and ask students to guess 

what these have in common (they all relate to green jobs).
Lesson Delivery (Explanation & Demonstration)
1. 	 Introduction to Green Skills and Environmental Protection
	 Concepts:

•	 Definition of green skills.
•	 Need for sustainability due to climate change and pollution.
•	 Simple steps to protect the environment.

	 Activity:
•	 Group brainstorming: Make a list of 10 everyday activities that can help protect the 

environment.
2. 	 Green Jobs and Their Importance
	 Concepts:

•	 Definition of green jobs and green-collar workers.
•	 Role of green jobs in different sectors: agriculture, construction, energy, ecotourism, solid 

waste management.
•	 Benefits: long-term employment, reduced pollution, innovation, sustainability.

	 Activity:
•	 Watch the recommended video: “Green Jobs: The Key to Sustainable Development”
•	 Discuss: What are some green jobs that interest you?

3. 	 Green Careers in Diverse Fields
	 Concepts:

•	 Green roles in agriculture, water conservation, solar/wind energy, building, tourism, and 
technology.

•	 Importance of Krishi Vigyan Kendras (KVKs), FPOs, electric mobility, and ecotourism.
	 Activity:

•	 Create a mind map titled “Green Jobs Around Us.”
•	 Match-the-sector game: Match a green job to its industry.

4. 	 Benefits of Green Jobs and Climate Action
	 Concepts:

•	 Green jobs reduce greenhouse gases, support ecosystem restoration, and offer climate 
change solutions.

•	 Role of National Action Plan on Climate Change (NAPCC).
•	 Concepts of afforestation, waste reduction, carbon capture, and sustainable materials.
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	 Activity:
•	 Debate: “Are green jobs the future of employment?”
•	 Reflection writing: “How can I contribute to a greener planet?”

Extension
•	 What is a green-collar worker?
•	 Name any two eco-friendly materials used in green buildings.
•	 How do solar panels help reduce environmental pollution?
•	 Why is drip irrigation considered a green job?
•	 What role do green jobs play in ecotourism?
•	 Can reusing old clothes be considered a green practice? How?
•	 What is the role of the Skill Council for Green Jobs?
•	 Why is e-waste management important?
•	 What are the advantages of using electric vehicles over petrol vehicles?
•	 What does the National Action Plan on Climate Change aim to achieve?
Evaluation
•	 MCQs, Fill in the blanks, and True/False based on green job definitions, sectors, and benefits.
•	 Short & Long answer questions as well as competency-based questions.
Practical Tasks:
•	 Poster: “My Dream Green Job”
•	 Group Activity: Design a small green business idea and present how it helps the environment.

Suggested Activity 

•	 Plant trees in the school/local area and learn about tree care.
•	 Groups create posters showing various green jobs and their importance.
•	 Students design a product (like bamboo toothbrush or solar lamp) and explain its environmental 

benefit. 
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Teaching Objectives

By the end of this lesson, students will be able to:
�� Understand the role of Python libraries like NumPy, Pandas, and Streamlit in data science and AI.
�� Perform array creation, indexing, and slicing using NumPy.
�� Create and manipulate Series and DataFrames using Pandas.
�� Handle missing data and import/export CSV files.
�� Build and deploy simple interactive web apps using Streamlit.
�� �Understand the basics of Linear Regression implementation in Python using scikit-learn and 

Streamlit.

Teaching Plan�

Number of Periods
Theory Practical

6 4

Introduction (Engagement)
Discussion Starters:
•	 Why do you think Python is preferred for AI and Data Science?
•	 Have you ever used Excel? How is a Pandas DataFrame similar or different?
Starter Activity:
•	 Display a dataset and ask: “How can we get average marks of students using Python with fewer 

lines of code?”
Lesson Delivery (Explanation & Demonstration)
1.	 Introduction to Python Libraries and Google Colab
	 Concepts:
	 =	 Importance of libraries (NumPy, Pandas, Streamlit)
	 =	 Introduction to Google Colab
	 Activity:
	 =	 Explore Colab interface
	 =	 Run a basic print(“Hello, Python!”) program

Python Programming II1

Part B-Subject Specific Skills
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2.	 NumPy – Array Creation and Indexing
	 Concepts:
	 =	 Rank 1 and Rank 2 arrays
	 =	 Indexing: positive and negative
	 =	 Modifying array values 
	 Activity:
	 =	 Create arrays and access elements using both positive and negative indexing
3.	 Array Slicing (1D and 2D)
	 Concepts:
	 =	 Slicing syntax and examples
	 =	 Slicing in 2D arrays 
	 Activity:
	 =	 Practice slicing to extract subarrays
4.	 Pandas – Series and DataFrames
	 Concepts:
	 =	 Creating Series using list, tuple, scalar
	 =	 Creating DataFrames from lists, dictionaries, and NumPy arrays
	 Activity:
	 =	 Convert a list of student names and marks into a DataFrame 
5.	 DataFrame Manipulation
	 Concepts:
	 =	 Add/update columns and rows
	 =	 Use of .loc[], .drop(), and attributes like .shape, .head(), .tail() 
	 Activity:
	 =	 Add a new column “Grade” to a DataFrame based on marks 
6.	 CSV Import and Export
	 Concepts:
	 =	 Using read_csv() and to_csv() for data import/export
	 Activity:
	 =	 Upload a CSV in Colab and display first 5 rows
7.	 Handling Missing Values
	 Concepts:
	 =	 Use of isnull(), dropna(), fillna()
	 =	 Strategy: When to drop and when to fill
	 Activity:
	 =	 Clean a dataset with missing values by both methods 
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8.	 Streamlit – Basics and Web App Development
	 Concepts:
	 =	 Streamlit functions: st.title(), st.write(), st.text_input(), etc.
	 =	 Creating and deploying an app on Streamlit Cloud 
	 Activity:
	 =	 Create a basic Streamlit app to collect student feedback 
9.	 Linear Regression in Python
	 Concepts:
	 =	 Using scikit-learn for linear regression
	 =	 User interface integration using Streamlit 
	 Activity:
	 =	 Create a predictor app for “Hours Studied vs Exam Score” 

Extension

=	 What are Python libraries and why are they useful?
=	 What is the difference between Rank 1 and Rank 2 arrays?
=	 How does negative indexing work in NumPy?
=	 What are the two primary data structures in Pandas?
=	 How can you read data from a CSV file using Pandas?
=	 What does the function fillna() do?
=	 What is Streamlit and how is it different from other Python libraries?
=	 What are some uses of DataFrame.head() and DataFrame.tail()?
=	 Why is Streamlit useful for machine learning projects?
=	 What does a Linear Regression model predict?

Evaluation

=	 MCQs on indexing, Pandas functions, Streamlit basics, and CSV handling.
=	 Short & Long answer questions as well as competency-based questions. 
Practical Tasks:
=	 Create a “Student Score Tracker” app using Streamlit
=	 Design a poster: “Top 5 Python Libraries for AI”

Suggested Activity

=	 Take a CSV file, clean it using Pandas, and build a Streamlit dashboard to visualise it.
=	 Students build their own “Score Predictor” using Streamlit and scikit-learn.
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Teaching Objectives

By the end of this lesson, students will be able to:
�� Understand the foundational steps in Data Science Methodology. 
�� Analyse real-world problems using a structured analytic approach.
�� Identify appropriate data requirements, sources, and formats.
�� Prepare data for model training through cleaning, feature engineering, and transformation.
�� Implement basic predictive models and evaluate their performance using key metrics.
�� Deploy AI models and understand the role of user feedback in refining models.
�� Differentiate between evaluation techniques like Train-Test Split and K-Fold Cross Validation.

Teaching Plan�

Number of Periods
Theory Practical

7 3

Introduction (Engagement)
Warm-up Discussion:
•	 Ask: “When solving a problem in daily life, how do you plan your steps?”
•	 Discuss how a simple task like planting a tree involves steps – link this to solving AI problems.
Starter Activity:
•	 Case scenario: A supermarket wants to manage stock using AI. How should they start? Guide 

students to the idea of a methodology.
Lesson Delivery (Explanation & Demonstration)
1.	 Introduction to Data Science Methodology
	 Concepts:
	 =	 Importance of structured methodology in AI
	 =	 10 steps of Data Science Methodology (by John Rollins)
	 =	 5 Modules: From Problem to Approach → Deployment to Feedback
	 Activity:
	 =	 Flowchart drawing: Students label and explain each stage in the methodology 
2.	 From Problem to Approach (Module 1)
	 Concepts:
	 =	 Business Understanding and Problem Scoping (5W1H)
	 =	 Analytic Approach (Regression, Classification, etc.)
	 =	 Four types of Data Analytics: Descriptive, Diagnostic, Predictive, Prescriptive
	 Activity:
	 =	 Match problem scenarios with the type of analytics and analytic approach

Data Science Methodology2
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3.	 From Requirements to Collection (Module 2)
	 Concepts:
	 =	 Data Requirements (5W1H framework)
	 =	 Types: Structured, Semi-Structured, Unstructured
	 =	 Data Sources: Primary, Secondary, Mixed 
	 Activity:
	 =	 Develop a 5W1H framework for a problem (e.g., predicting exam scores)
	 =	 Identify data types and possible sources 
4.	 From Understanding to Preparation (Module 3)
	 Concepts:
	 =	 Data understanding using statistics and visualisation
	 =	 Data cleaning: handling missing values, outliers, inconsistencies
	 =	 Feature engineering and transformation 
	 Activity:
	 =	 Analyse a sample dataset to identify errors, missing values, and suggest improvements
5.	 From Modelling to Evaluation (Module 4)
	 Concepts:
	 =	 Descriptive vs Predictive Modelling
	 =	 Model Evaluation: Accuracy, Precision, Recall, F1-Score
	 =	 Validation: Train-Test Split, K-Fold Cross Validation
	 Activity:
	 =	 Confusion matrix activity: Calculate metrics from a given example
	 =	 Explain overfitting vs underfitting with examples 
6.	 From Deployment to Feedback (Module 5)
	 Concepts:
	 =	 Deployment process and stakeholder collaboration
	 =	 Feedback loop and iterative improvement
	 =	 Real-world example: AI in inventory prediction for supermarkets 
	 Activity:
	 =	 Role-play: Present an AI model to a client (students act as data scientists and clients)
	 =	 Class debate: Why continuous feedback is essential in AI projects 

Extension (Further Exploration)

=	 Why is defining the problem correctly important in a data science project?
=	 What are the different types of data formats used in AI?
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=	 Can you explain the difference between Diagnostic and Predictive Analytics?
=	 What is the role of feature engineering?
=	 How do we know our model is performing well?
=	 Why is feedback essential after deploying an AI model?
=	 What is overfitting? How can it be avoided?
=	 Name any two metrics used to evaluate a classification model.
=	 What is the benefit of using K-Fold Cross Validation?
=	 How is real-world data different from training data?

Evaluation (Assessments & Review)

Objective Quiz:
=	 MCQs based on modules, analytics types, model evaluation metrics.
=	 Short & Long answer questions as well as competency-based questions.
Practical Tasks:
=	 Design a “Data Science Cycle” poster
=	 Develop a mini capstone idea (problem + approach + data needs)

Suggested Activity

=	 Students choose a problem and complete the 5W1H framework and analytic approach
=	 Provide a flawed dataset and ask students to clean, structure, and suggest features.
=	 Given a confusion matrix, teams compete to calculate metrics fastest and most accurately. 

Teaching Objectives

By the end of this lesson, students will be able to:
�� Understand the concept and purpose of Computer Vision (CV).
�� Explain how machines capture, process, and interpret visual data.
�� Understand image representation, resolution, bit depth, and pixel structure.
�� �Describe the stages of the Computer Vision process: acquisition, preprocessing, feature extraction, 

detection/segmentation, and high-level processing.
�� Apply basic image processing techniques using online tools or OpenCV.
�� Explore real-world applications and challenges of Computer Vision.
�� Build a simple image classifier using Teachable Machine and deploy it on a website.

Making Machines See (Computer Vision)3
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Teaching Plan�

Number of Periods
Theory Practical

6 4

Introduction (Engagement)
Starter Questions:
=	 Can machines see like humans? How?
=	 Why is it hard for computers to understand photos? 
Interactive Activity:
=	� Show a set of blurred and clear images to students and ask which one a human would identify 

easily—and then discuss how machines might do the same using Computer Vision.
Lesson Delivery (Explanation & Demonstration)
1.	 Understanding Computer Vision (CV)
	 Concepts:
	 =	 Definition and goals of CV
	 =	 CV vs Human Vision
	 =	 Importance of image indexing and retrieval
	 Activity:
	 =	 Diagram comparison: Human Eye vs Computer Vision Pipeline
	 =	 Watch short video on CV applications (e.g., Face unlock, Self-driving cars)
2.	 How Machines See
	 Concepts:
	 =	 Role of cameras and sensors
	 =	 Concept of pixels, resolution, and bit depth
	 =	 RGB model, grayscale, and binary images
	 Activity:
	 =	 Pixel Grid Exploration: Students view images at different resolutions and identify pixelation
3.	 Computer Vision Process (5 Stages)

Stage Description
Image Acquisition Capturing real-world images via sensors or cameras
Preprocessing Improving image quality: noise reduction, resizing, cropping, 

normalisation
Feature Extraction Identifying edges, corners, textures, colours
Detection & Segmentation Object classification, object detection, semantic/instance 

segmentation
High-Level Processing Scene understanding, context analysis, decision making
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	 Activity:
	 =	 Flowchart creation of the CV process with image examples at each stage 
4.	 Representing and Manipulating Images
	 Concepts:
	 =	 Digital image representation (grayscale, RGB)
	 =	 Numerical and binary pixel values
	 =	 Introduction to pixel art and binary image conversion
	 Hands-On Activity:
	 =	 Use online tools to convert image → grayscale → pixel values → copy to Word/Docs 
	 =	 Try Pixel Art using Google Sheets template  
5.	 OpenCV Basics (for advanced learners)
	 Concepts:
	 =	 OpenCV library usage in Python
	 =	 Loading, displaying, resizing, and converting images
	 =	 Canny edge detection and Gaussian blur
	 Code Demo (Colab):
	 =	 Show students how to load and convert an image to grayscale using OpenCV
	 =	 Demonstrate edge detection and discuss use cases (e.g., object boundaries) 
6.	 Applications of Computer Vision
	 Examples:
	 =	 Facial recognition
	 =	 Healthcare diagnostics (X-ray, CT scans)
	 =	 Autonomous vehicles (object detection, lane recognition)
	 =	 Surveillance, OCR, AR/VR, Retail automation
	 Code Demo (Colab):
	 =	� Case study matching: Identify CV usage in various industries (e.g., Amazon Go, Facebook 

tagging)
7.	 Challenges and Ethics
	 Topics:
	 =	 Data quality issues, lighting variation, noise
	 =	 Deepfakes and misinformation
	 =	 Privacy concerns and surveillance ethics
	 =	 Biased AI models
	 Group Discussion:
	 =	 Discuss: “Should facial recognition be used in public spaces?” 
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8.	 Project: Image Classifier Website with Teachable Machine
	 Task Flow:
	 =	 Visit Teachable Machine
	 =	 Choose Image Project → Add classes → Train model 
	 =	 Export using TensorFlow.js
	 =	 Use Weebly or Google Sites to embed JavaScript code
	 =	 Publish and test the model
	 Activity:
	 =	 Each student builds a 2-class model and deploys it on a free website 

Extension 

=	 What is the difference between semantic and instance segmentation?
=	 How does OpenCV help in computer vision tasks?
=	 What is a pixel? Why is its value important?
=	 Why do we convert images to grayscale?
=	 What are bounding boxes used for?
=	 What role does Gaussian Blur play in image preprocessing?
=	 What are the ethical challenges in face recognition systems?
=	 How does histogram equalization help in image enhancement?
=	 What happens during edge detection?
=	 Name one deep learning model used in image classification. 

Evaluation (Assessments & Review)

Objective Questions:
=	 MCQs, True/False, Fill in the blanks (from textbook exercises).
=	 Short & Long answer questions as well as competency-based questions.
Practical Tasks:
=	 Draw a labelled diagram of the CV pipeline
=	 Design a “Fake vs Real” awareness poster on Deepfakes 

Suggested Activity

=	 Train a 2-class image classifier using Teachable Machine.
=	 Use grayscale and pixel extractors to recreate simple shapes or icons. 

Teaching Objectives

Orange Data Mining Tool4
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By the end of this lesson, students will be able to:
�� Understand what data mining is and why it is important.
�� Install and set up Orange Data Mining Tool.
�� Identify and use various widgets in Orange for data preprocessing, modelling, and evaluation.
�� Create data workflows using Orange’s visual interface.
�� Perform tasks such as classification, regression, clustering, and visualisation using Orange.
�� Explore AI domains like Data Science, NLP, and Computer Vision using Orange.
�� Build practical projects using datasets and models via Orange’s drag-and-drop interface.

Teaching Plan�

Number of Periods
Theory Practical

6 4

Introduction (Engagement)
Starter Questions:
=	 Have you ever received recommendations on a shopping website? How do you think it works?
=	 What if you could analyse and predict trends without writing a single line of code?
Engagement Activity:
=	� Show a simple demo of Orange workflow on screen – drag and drop File → Data Table → Scatter 

Plot.
=	 Ask: “What do you think each block (widget) is doing?”
1.	 Introduction to Data Mining and Orange Tool
	 Concepts:
	 =	 What is Data Mining?
	 =	 Importance in decision-making
	 =	 Introduction to Orange Tool: open-source, visual, widget-based
	 Activity:
	 =	� Class discussion on everyday examples of data mining (e.g. product recommendations, fraud 

detection)
2.	 Installing and Exploring Orange Tool
	 Concepts:
	 =	 Installation steps for Windows and Mac
	 =	 Interface: Menu bar, Widgets, Canvas, Connectors
	 Activity:
	 =	 Live walkthrough: Download and install Orange
	 =	 Students identify components on the screen
3.	 Using Default Widgets
	 Concepts:
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	 =	 Categories of widgets: Data, Transform, Visualize, Model, Evaluate, Unsupervised
	 =	 Examples: File, Data Table, Impute, Scatter Plot, Random Forest, Test and Score
	 Activity:
	 =	 Match-the-widget game using flashcards (students match widget names with purposes) 
4.	 Creating a Basic Workflow
	 Concepts:
	 =	 Connecting widgets using connectors
	 =	 Understanding input-output data flow 
	 Activity:
	 =	 Hands-on: File → Data Table → Scatter Plot 
	 =	 Task: Visualise and explore built-in datasets (e.g., Iris or Heart Disease)
5.	 Model Building and Evaluation
	 Concepts:
	 =	 Classification using Random Forest, Regression using Linear Regression
	 =	 Model evaluation metrics: Accuracy, Precision, Recall, F1-score, Confusion Matrix
	 Activity:
	 =	 Use Salary_Data for regression
	 =	 Use Heart_Disease dataset for classification
	 =	 View performance using Test and Score, Confusion Matrix 
6.	 Exploring AI Domains
	 Concepts:
	 =	 NLP using Text Widgets (e.g., Corpus, Preprocess Text, Word Cloud)
	 =	 Computer Vision using Image Analytics Widgets (e.g., Import Images, Image Embedding) 
	 Activity:
	 =	 Text analysis on Grimm Tales corpus → generate Word Cloud
	 =	 Image classification using flower dataset (Roses, Lilies, Sunflowers)

Extension Activity

=	 What is the role of the File widget in a workflow?
=	 How does the Impute widget handle missing values?
=	 What kind of data is suitable for classification?
=	 What do the colours in a Scatter Plot represent?
=	 What is the difference between supervised and unsupervised learning in Orange?
=	 Name one benefit of using Orange for beginners in AI.
=	 What is the use of the Preprocess Text widget?
=	 How does Image Embedding help in classification?
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=	 What is the role of connectors in a workflow?
=	 Can you use Orange for projects without coding?

Evaluation

=	 MCQs based on widgets, workflow, AI domains, evaluation metrics.
=	 Short & Long answer questions as well as competency-based questions.
Creative Tasks:
=	 Design a sample Orange workflow diagram and label all parts.
=	 Project: Create a classification model to differentiate fruits and vegetables using nutrition data.

Suggested Activity

=	 Use Orange to analyse the IRIS dataset: Visualise → Classify → Evaluate
=	 Students choose an article → build their corpus → preprocess → create Word Cloud
=	 Perform image classification using Image Analytics widgets (flowers, animals)
=	 Build a Logistic Regression model using Simple Loan Dataset and test it on new entries.

Teaching Objectives

By the end of this lesson, students will be able to:
�� Understand the concept and characteristics of Big Data.
�� Differentiate between Small Data and Big Data.
�� Identify the types and sources of Big Data.
�� Explain the 6Vs framework (Volume, Variety, Velocity, Veracity, Value, Variability).
�� Recognise the importance of Data Analytics and Big Data Analytics.
�� Describe the applications, benefits, and challenges of Big Data in real-world contexts.
�� Apply Big Data Analytics using the Orange Data Mining Tool.
�� Understand career opportunities in Big Data and Analytics.

Teaching Plan�

Number of Periods
Theory Practical

6 4

Introduction (Engagement)
Starter Discussion:
=	� Ask: “How many messages, videos, or images do you think are shared every second on the 

internet?”
=	� Show stats from social media (e.g. YouTube uploads per minute) and ask: “How do companies 

manage such huge data?”

Introduction to Big Data and Data Analytics5
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Engagement Activity:
=	� Share a case study (e.g. how supermarkets predict demand using data). Let students identify the 

role of data in decision-making.
Lesson Delivery (Explanation & Demonstration)
1.	 Introduction to Data and Big Data
	 Concepts:
	 =	 Definition of data (raw facts), Small Data, and Big Data
	 =	 Real-life examples of Small vs Big Data
	 Activity:
	 =	 Students categorise examples into Small or Big Data
2.	 Characteristics of Good Data
	 Concepts:
	 =	 Accuracy, Completeness, Reliability, Relevance, Timeliness
	 Activity:
	 =	 Real-life scenario quiz: Is the data “reliable”? “accurate”?
3.	 Characteristics of Big Data – 6Vs
	 Concepts:
	 =	 Volume, Variety, Velocity, Veracity, Value, Variability
	 =	 Real-world examples for each V
	 Activity:
	 =	 Create a “6Vs of Big Data” infographic or chart 
4.	 Types and Sources of Big Data
	 Concepts:
	 =	 Structured, Unstructured, Semi-structured Data
	 =	 Sources: Transactional, Machine, Social
	 Activity:
	 =	 Students match data types to sources (e.g. “bank statement” → structured)
5.	 Introduction to Data Analytics
	 Concepts:
	 =	 Definition, importance, and fields where analytics is used (healthcare, retail, finance, etc.)
	 =	 Tools and techniques (Excel, Python, Tableau, etc.)
6.	 Types of Big Data Analytics

	

Type Purpose Example Tool
Descriptive What happened? Excel, SQL
Diagnostic Why did it happen? Python, R
Predictive What could happen? Scikit-learn
Prescriptive What should be done? IBM Watson
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	 Activity:
	 =	 Case-based matching activity using analytics types
5.	 Using Orange Data Mining Tool for Big Data Analytics
	 Concepts:
	 =	 Workflow: File → Preprocess → Model (e.g., Logistic Regression) → Evaluate
	 =	 Widgets: File, Data Table, Impute, Preprocess, Test & Score, Predictions
	 Activity:
	 =	� Students analyse heart disease dataset in Orange: impute missing values, apply logistic 

regression, and view predictions 
6.	 Applications, Advantages and Disadvantages of Big Data
	 Concepts:
	 =	 Applications in healthcare, retail, finance, etc.
	 =	 Benefits: better decision-making, cost efficiency, improved customer satisfaction
	 =	 Disadvantages: privacy risks, high costs, data quality issues 
	 Activity:
	 =	 Debate: “Does Big Data help more than it harms?” 

Extension (Further Exploration)

=	 What does each V in the 6Vs framework stand for?
=	 How is unstructured data different from structured data?
=	 Why is Big Data important in today’s world?
=	 What challenges arise from collecting massive data?
=	 Name one tool used for Big Data analytics.
=	 How does Netflix use Big Data?
=	 Why is Veracity important in analytics?
=	 What is the role of machine learning in Big Data?
=	 What kind of data does a smartwatch generate?
=	 How is Big Data helping smart cities? 

Evaluation (Assessments & Review)

=	 MCQs and Fill-in-the-blanks on data types, 6Vs, analytics types.
=	 Short & Long answer questions as well as competency-based questions. 
Creative Tasks:
=	 Create a mind map on “Big Data in Our Daily Life”
=	 Group Project: Use Orange to analyse a dataset and present insights.

Suggested Activity

=	 Simulate fast-moving data in class and ask students to process & sort it in real-time
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=	 Predict the presence of heart disease using Orange’s Logistic Regression workflow.

Teaching Objectives

Students will learn about:
�� Understand the concept and structure of neural networks and how they mimic the human brain.
�� Identify the different layers and components of a neural network.
�� Explain how neural networks learn using weights, bias, activation functions, and propagation.
�� �Understand and differentiate types of neural networks such as Perceptron, FFNN, CNN, RNN, 

and GAN.
�� Explore real-world applications and societal impacts of neural networks.
�� �Build and test a simple neural network using Python and tools like TensorFlow Playground and 

Perceptron Demo.

Teaching Plan�

Number of Periods
Theory Practical

6 4
�
Introduction (Engagement)
Discussion Starters:
=	 How does your phone unlock using face recognition?
=	 What makes Netflix suggest the exact show you like? 
Activity:
=	� Show video clips of AI applications using neural networks (e.g., face unlock, chatbot, 

recommendation system).
=	 Ask students to guess how machines recognise patterns or make decisions.
Lesson Delivery (Explanation & Demonstration)
1.	 What is a Neural Network?
	 Concepts:
	 =	 Definition and biological inspiration
	 =	 Artificial Neural Networks (ANNs) and real-life applications
	 Activity:
	 =	 Play the “Wolf, Sheep, and Cabbage” game to demonstrate learning from experience 
2.	 Structure of Neural Networks
	 Concepts:
	 =	 Layers: Input, Hidden, Output
	 =	 Data flow through nodes, weights, and biases

Understanding Neural Networks6
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	 Activity:
	 =	 Flowchart drawing of a neural network with sample inputs
3.	 Components of a Neural Network
	 Concepts:
	 =	 Neurons, Weights, Bias, Activation Functions (ReLU, Sigmoid, Tanh), Connections
	 =	 Propagation: Forward and Backward (Backpropagation)
	 =	 Learning Rule and Epoch
	 Activity:
	 =	 Solve the “Spam Detection” and “Swimming Decision” case studies step-by-step
4.	 Types of Neural Networks
	 Types Covered:
	 =	 Perceptron (basic binary classification)
	 =	 Feedforward Neural Network (FFNN)
	 =	 Convolutional Neural Network (CNN)
	 =	 Recurrent Neural Network (RNN)
	 =	 Generative Adversarial Network (GAN)
	 Activity:
	 =	 Use TensorFlow Playground to visualise FFNNs
	 =	 Explore CNN layers using Adam Harley’s visualiser
	 =	 Play GAN game to understand how generators and discriminators work
5.	 Applications and Impacts
	 Concepts:
	 =	 Use in industries: healthcare, finance, entertainment, smart assistants
	 =	 Challenges: data privacy, algorithmic bias, job displacement
	 Activity:
	 =	 Group discussion on: “Are neural networks helping or harming society?” 
6.	 Coding a Simple Neural Network (For Advanced Learners)
	 Concepts:
	 =	 Build a model using TensorFlow/Keras
	 =	 Dataset: Hours worked vs Weekly income
	 =	 Plot training loss and make predictions
	 Hands-On:
	 =	 Run Python code from the PDF in Google Colab
	 =	 Interpret model output and loss graphs 

Extension Activity

=	 What makes a neural network “deep”?
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=	 Why do we use activation functions?
=	 What is backpropagation in neural networks?
=	 Name one application of CNN and one of RNN.
=	 How does GAN generate realistic images?

Evaluation

=	 Based on MCQs, fill in the blanks, and true/false.
=	 Short & Long answer questions as well as competency-based questions.
Suggested Activity
=	 Design your own neural network architecture (input → hidden → output)

Suggested Activity

=	 Use https://www.i-am.ai/neural-numbers.html to observe digit recognition.
=	 Experiment with features, learning rate, and activation functions for better prediction.
=	 Use the Python code provided to train and predict income based on hours worked.

Teaching Objectives

Students will learn about:
�� Understand what Generative AI is and how it differs from traditional AI.
�� Explain the working of Generative AI using models like GANs and VAEs.
�� Identify key applications of Generative AI in text, image, video, and audio generation.
�� Distinguish between generative and discriminative models.
�� Explore Large Language Models (LLMs) and their applications.
�� Recognise the ethical and societal concerns related to Generative AI.
�� Practise using hands-on tools for Generative AI content creation. 

Teaching Plan�

Number of Periods
Theory Practical

7 5

Introduction (Engagement)
Discussion Starters:
=	 Ask: “Can a machine write a poem or create a painting?”
=	 Show examples of AI-generated content (e.g., images from DALL·E or ChatGPT text).

Generative AI7
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Activity:
=	� Icebreaker: Students describe an imaginary scene. The teacher uses a text-to-image AI to generate 

it live.
Lesson Delivery (Explanation & Demonstration)
1.	 Introduction to Generative AI
	 Concepts:
	 =	 Definition and capabilities (text, images, music, videos, code)
	 =	 Difference from traditional AI 
	 Activity:
	 =	 Think-Pair-Share: List real-world examples of AI-generated content
2.	 How Generative AI Works
	 Concepts:
	 =	 Deep learning, neural networks
	 =	 Key architectures: GANs and VAEs 
	 Activity:
	 =	 Compare generator vs. discriminator with a roleplay exercise 
3.	 Generative vs Discriminative Models
	 Concepts:
	 =	 Generative: P(x, y) → Naive Bayes, GANs
	 =	 Discriminative: P(y|x) → SVM, Logistic Regression
	 Activity:
	 =	 Chart: Compare differences in purpose, training, data handling 
4.	 Applications of Generative AI
	 Concepts:
	 =	 Image Generation: DALL·E, Firefly
	 =	 Text Generation: ChatGPT, Gemini
	 =	 Video Generation: VEED, Synthesia
	 =	 Audio Generation: AIVA, ElevenLabs
	 Activity:
	 =	 Group presentations on one domain each (Text, Image, Audio, Video) 
5.	 Exploring Large Language Models (LLMs)
	 Concepts:
	 =	 What are LLMs and why are they “large”?
	 =	 Popular LLMs: GPT-4o, Gemini, LLaMA, Claude, Mixtral
	 Activity:
	 =	 Use Gemini or ChatGPT for writing a poem or summarising a paragraph
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6.	 Hands-on Exploration of Generative AI Tools
	 Concepts:
	 =	 Canva: AI-generated image creation
	 =	 Google Gemini: Prompt-based text generation
	 =	 VEED: Text-to-video generation
	 =	 Animaker: Training video generation
	 =	 Musick.ai: AI-generated music
	 =	 ChatGPT: Text and chatbot interaction
	 =	 Gemini API + Python: Build a simple chatbot (for advanced learners)
7.	 Prompt Engineering
	 Concepts:
	 =	 Importance of well-structured prompts
	 =	 Prompt enhancement techniques (persona, format, audience)
	 Activity:
	 =	 Practice: Turn weak prompts into strong prompts with examples 
8.	 Ethical and Social Concerns
	 Concepts:
	 =	 Deepfakes
	 =	 Bias and discrimination
	 =	 Copyright and plagiarism
	 =	 Transparency and misuse
	 Activity:
	 =	 Debate: “Should AI be allowed to generate creative works?”

Extension Activity

=	 What is the role of the generator and discriminator in a GAN?
=	 How are LLMs different from traditional models?
=	 What makes a prompt more effective for AI tools?
=	 What are the dangers of deepfake content?
=	 How can AI-generated content be ethically cited?

Evaluation

=	 MCQs, Fill in the blanks, True/False based on models, tools, and key concepts.
=	 Short & Long answer questions as well as competency-based questions.
Creative Tasks:
=	 Create a custom AI art piece using Canva
=	 Generate a video script and visualise it using VEED
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Suggested Activity

=	 Students document their experience of using tools like ChatGPT, Canva, and VEED.
=	 Simulate a media ethics board meeting on how to manage AI-generated news articles.

Teaching Objectives

By the end of this lesson, students will be able to:
�� Understand the concept and evolution of storytelling and data storytelling.
�� Identify the key elements of a good story and apply them to data storytelling.
�� Use data visuals like charts and graphs to enhance storytelling impact.
�� Understand the Freytag’s Pyramid structure and apply it to build a data story.
�� Create, analyse, and present data stories using real or sample datasets.
�� Recognise the ethical responsibilities in data storytelling.
�� �Differentiate between narrative, data, and visuals and how they integrate into compelling data 

stories.

Teaching Plan�

Number of Periods
Theory Practical

6 4

Introduction (Engagement)
Discussion Starters:
=	 Ask: “Have you ever heard a story that changed your mind about something?”
=	� Show an infographic or a data story video (e.g. Neha’s Café or Dove’s Real Beauty) and ask: “Why 

do you think this data is more memorable than just numbers?”
Engagement Activity:
=	 Use a short narrative and ask students how they’d visualise it using a chart.
Lesson Delivery (Explanation & Demonstration)
1.	 What is Storytelling and Data Storytelling 
	 Concepts:
	 =	 Storytelling: Sharing ideas and emotions across cultures and time.
	 =	� Data Storytelling: A blend of data, visuals, and narrative to create engaging, insightful, and 

actionable stories.
	 Activity:
	 =	 Students define storytelling in their own words.
	 =	 Discussion on storytelling in films, books, and now in business and technology.

Data Storytelling8
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2.	 Evolution and Elements of a Story
	 Concepts:
	 =	 Evolution from cave paintings to digital storytelling
	 =	 Key elements: Characters, Setting, Plot, Conflict, Resolution, Insight 
	 Activity:
	 =	 Choose a movie and complete a story analysis table with its plot, conflict, resolution, etc.
3.	 Key Components of a Data Story

Element Role in Storytelling
Data Factual foundation
Narrative Connects data logically and emotionally
Visuals Clarifies and enhances understanding

	 Activity:
	 =	 Create a mini data story from a chart (e.g. ML course interest levels before & after) 
4.	 Using Freytag’s Pyramid in Data Stories
	 Concepts:
	 =	 Exposition → Rising Action → Climax → Falling Action → Resolution
	 Activity:
	 =	� Group project: Create a data story using Freytag’s Pyramid (e.g. Climate change or library 

book return issue)
5.	 Types of Data & Their Visualisations
	 Data Types & Visuals:
	 =	 Text: Word Clouds
	 =	 Numeric: Line, Column, Pie, Bar, Histogram, Scatter
	 =	 Mixed: FacetGrids
	 =	 Stock: Candlestick Charts
	 =	 Geographical: Maps
	 Activity:
	 =	 Match data types to appropriate visuals + Hands-on with tools like Infogram or Excel
6.	 Steps to Create a Data Story
	 =	 Collect and organise data
	 =	 Choose suitable visuals
	 =	 Analyse data patterns
	 =	 Create a narrative
	 =	 Present it with context
	 Activity:
	 =	 Storytelling lab: Use Excel to graph housing data or climate data and write the story 
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7.	 Ethical Data Storytelling
	 Ethical Principles:
	 =	 Accuracy & Integrity
	 =	 Transparency
	 =	 Privacy & Fairness
	 =	 Audience Responsibility
	 Activity:
	 =	 Case scenarios: Identify and correct unethical data storytelling examples 

Extension (Further Exploration)

=	 Why is it important to combine visuals with data?
=	 What makes a data story more engaging than just a table?
=	 How can storytelling influence decision-making?
=	 What is the risk of misleading visuals?
=	 What does “resolution” mean in storytelling? 

Evaluation (Assessments & Review)

=	 MCQs based on key terms, data types, Freytag’s Pyramid, and visualisation tools.
=	 Short & Long answer questions as well as competency-based questions.
Practical Tasks:
=	 Redesign a data story with better visuals and narration.
=	 Create a campaign story like Whirlpool’s Care Counts using data + empathy.

Suggested Activity

=	 Create a datastory on pollution.
=	 Ask students to debate on use of Data Storytelling in Healthcare vs. Marketing/


